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關於 i-Tree（About i-Tree） 

i-Tree是來自美國林務局最先進的同儕評閱（peer-reviewed）軟體套件，其提供

都市及社區林業分析與效益評估工具。i-Tree 工具藉由量化環境樹木提供的服

務及評估都市林結構，以幫助各種大小的地區加強他們的都市林管理與推廣

度。 

 

i-Tree已被社區、非營利組織、顧問、志工及學生用於記錄各種規模的都市

林，從單一樹木乃至社區、都市甚至整個國家。透過了解當地樹木實際提供的

生態系服務，i-Tree使用者可連結都市林管理活動、環境品質及社區的可居住

性。無論研究目標為單一樹木或整個森林，i-Tree的基礎資料供你證明價值及

確定優先度以做更有效的決策。 

 

由美國林務局與眾多合作夥伴共同開發，i-Tree設於公共網域上，可向 i-Tree網

站（www.itreetools.org）索取授權。林務局、Davey樹木專家公司（Davey Tree 

Expert Company）、植樹節基金會（Arbor Day Foundation）、市植樹師學會

（Society of Municipal Arborists）、國際樹藝協會（International Society of 

Arboriculture）以及 Casey Trees 皆已成為合作夥伴以利未來發展、傳播與為此

套件提供技術支持。 

 

i-Tree產品（i-Tree Products） 

i-Tree軟體套件 5.0版本包含以下各都市林分析工具及應用程式。 

 

i-Tree Eco 提供整個都市林的概況。其使用來自社區隨機分布樣區的現場資料

及當地每小時空氣汙染和氣象資料，以量化都市林結構、環境影響與對社區的

價值。 

 

i-Tree Streets側重於生態系服務及一個都市行道樹族群的結構。它使用一個樣

本或完整普查量化並將每棵樹的年度環境與美學效益以美元價格計算，包含節

約能源、改善空氣質量、減少二氧化碳、雨水控制及房地價增幅。 

 

i-Tree Hydro 是第一個針對植被的都市水文模型。其模擬都市林覆蓋變更的影

響，及流域層不透水表面的每小時河流流量和水質。 

 

i-Tree Vue讓你自由使用全國土地覆蓋資料庫（National Land Cover Database，

NLCD）的衛星圖像以評估社區的土地覆蓋，包含樹冠及當前都市林提供的一

些生態系服務。其也可模擬種植方案對未來效益的影響。 

 

i-Tree Species Selector 是一個獨立的工具，用於幫助都市林管理者根據環境功

能和地理區域選擇最適合的樹種。 
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i-Tree Storm幫助你在一場嚴重的颶風天災過後，立即以簡單、可靠又有效的

方式評估廣泛的社區損害。它適用於各種社區類型及大小，並提供關於時間與

減輕災害所需資金的資訊。 

 

i-Tree Design 是一個簡易的線上工具，提供一片樹林中單一樹木的評估平台。

此工具連接 Google地圖，使你了解樹木選擇、樹木大小及放置位置將如何影響

能源使用和其它效益。此工具仍在早期開發階段，更多精密的功能選項會在未

來版本釋出。 

 

i-Tree Canopy 提供一個快速簡便的方法，透過使用適合的 Google Maps 航空圖

像，產生土地覆蓋類型（如，樹木冠蓋）的有效統計性的估計。透過使用這些

資料，城市森林管理者可估計樹冠覆蓋、設立樹冠目標，及順利地進行追蹤，

且能為 i-Tree Hydro和其它需要土地覆蓋資料的專案估計所需數值。 

 

免責聲明（Disclaimer） 

本出版物中所使用之商品、商號或公司名稱僅為提供讀者資訊和便利，並非排

除其它可能適合之任何產品或服務的使用方式，所提及之商品、商號或公司名

稱也非受到美國農業部或林務局的官方認可或批准。標籤「i-Tree Software Suite 

v. 5.0」所發布之軟體，將不提供任何形式的擔保。它的使用受到最終用戶許可

協議（End User License Agreement，EULA）管轄，使用者在安裝前需先同意接

受該協議。 

 

回饋（Feedback） 

i-Tree開發團隊積極尋求關於此產品的任何回饋意見：軟體套件、使用手冊，

或是開發、推廣、支持和精細化的過程。請將評論根據 i-Tree支持頁面所列出

的方式寄送：http://www.itreetools.org/support/ 

  

http://www.itreetools.org/support/
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介紹（Introduction） 

i-Tree Storm 是以風暴災害評估程序工具（Storm Damage Assessment Protocol 

Utility）為基礎，建立一套標準方法，以簡單、可靠、高效率的方式，在一場

劇烈風暴後立即評估廣泛的災害。此評估方法適用於各種社區類型和大小，並

提供減輕風暴破壞所需的時間和資金資訊。 

 

樣本街道區段將從社區中隨機選取，並進行調查，時間和成本估計皆會被記

錄。一個 MS Excel 所開發的模板可執行所有計算，估計減輕災害的成本及整個

社區的殘骸清理費用。PDA應用程式有助於資料收集，選擇或需要手動完成工

作的使用者則可使用紙製表格。 

 

該協議包括評估社區行道樹的自選風暴前階段，針對嚴重風暴後所需的清理成

本，提供一個粗略的估算。一個特別的風暴調整試用版（Hurricane Adaptation 

(beta)）模型能利用歷史資料以改善這類風暴的估計。這個版本仍在開發中，請

踴躍提供回饋。 

 

有關 Storm 模型的更多資訊，請參考 i-tree網站（www.itreetools.org）Resources

中「An Initial Storm Damage Assessment Protocol for Urban and Community 

Forests」。 

 

關於本手冊（About This Manual） 

本手冊將提供進行 Storm 專案所需的所有資訊。我們從安裝軟體開始，之後會

介紹四個專案階段： 

 

第一階段：準備（Phase I: Getting Prepared）：在本節中，我們會討論一開始

需做出的決策，比如，如何、何時以及那些資料將被收集。第一階段也包含針

對一般意外準備的有用指示，包括計畫的溝通、人員、備份及存儲。在這個階

段，你也會收集一般資料，如緊急工作人員的成本估算。最後，你將創建隨機

樣本並為資料收集準備 PDA或手動表格。 

 

第二階段：風暴前（Phase II: Before the Storm）：若欲針對你的樣本進行風暴

前調查，在本節中，我們將解釋需收集哪些資料及如何使用 PDA或表格工作。

收集資料後，你將傳送資料到桌面上，回答一些設置問題，及查看分析結果。 

 

第三階段：風暴後（Phase III: After a Storm）：本節將介紹風暴後需要收集的

資料，並敘述如何使用 PDA和表格工作。收集資料後，你將傳送資料到桌面

上，回答一些設置問題，及查看分析結果。 

 

附錄一：隨機抽樣工作書（Appendix I：Random Sample Workbook）： 〈附
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錄一〉提供使用 ArcGIS 軟體產生隨機樣區的其中一種方法的步驟。 

 

附錄二：資料表單（風暴）（Appendix 2: Data Forms (Storm)）：進行常規

Storm 分析的所有表格皆收錄於此。 

 

附錄三：資料表單（颶風調整）（Appendix 3: Data Forms (Hurricane 

Adaptation)）：進行颶風調整版本的所有表格皆收錄於此。 
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安裝（Installation） 

 

系統要求（System Requirements） 

桌上型/筆記型電腦的需求（Desktop/laptop computer requirements） 

最低硬體（Minimum hardware）： 

 Pentium 或 1600 MHZ 或更快的處理器 

 512 MB可用記憶體 

 至少 500MB的可用硬碟空間 

 顯示器解析度要 800 x 600或更佳 

 

軟體（Software）： 

 Windows 作業系統 XP SP2或更高（包含Windows 7） 

 Microsoft Excel 

 針對 PDA使用者，Windows XP 需 ActiveSync 4.5 或更高版本，Vista和

Windows 7 需Mobile Device Center 6.0 或更高版本（包含在 i-Tree安裝

內） 

 

實地資料收集儀器的需求（Requirements for field data collection devices） 

幾種智慧型手機和 PDA設備可與 i-Tree應用程式一起使用。具備下列基本規格

的設備，擁有使用 i-Tree應用程式的最佳性能和相容性： 

 Windows Mobile 5.0–6.5作業系統（OS7 目前無法相容） 

 最低螢幕解析度 240 x 320；640 x 480 最佳。 

 

安裝（Installation） 

安裝 Storm： 

1) 進入此網站（www.itreetools.org）下載軟體，或將 i-Tree軟體安裝光碟放

入 CD/DVD光碟機中。 

2) 按照螢幕的指示執行 i-Tree setup.exe檔案。根據所需的安裝檔案不同，

這將花幾分鐘的時間。 

3) 按照安裝小精靈的指示以完成安裝（建議安裝在預設路徑）。 

 

你可以藉由點擊 Help > Check for Updates 隨時檢查最新的更新。 

 

構件（Components） 

安裝包包含三個 Storm 構件：Excel 模板、PDA應用程式，以及連結這兩個工

具的介面。PDA應用程式可使用 PDA執行，其為專門設計用以收集 Storm 資

料的工具。Excel 模板應於桌機執行，其使用編制期收集的資料，估算關於你社

區在風暴中的全部損失。介面則能傳輸你的隨機樣本資料到 PDA，且在資料收

http://www.itreetools.org/
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集後，從 PDA轉移資料到模板中。若你不使用 GIS 創建你的隨機樣本，使用

介面手動輸入你的樣區資訊是最簡單的。 
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第一階段：準備（Phase I: Getting Prepared） 

 

一般應急計畫（General Emergency Planning） 

i-Tree Storm 屬於一般範圍內的社區緊急計畫和緊急應對。在經歷一個災難後，

為了使社區適當和即時反應，此計畫是至關重要的。我們強烈建議你針對風暴

對你都市林的傷害，建立一個一般性計畫。對社區官方人員而言十分有用的指

南可於 Tree Emergency Plan Worksheet（L. Burban, J. Hermann, and K. Himanga）

中找到。樹木管理者也可諮詢 Storms Over the Urban Forest（L. Burban, J. 

Andresen）。關於兩者的更多資訊皆能於 i-Tree網頁（www.itreetools.org）的

Resources 找到。 

 

資料收集人員（Data collection personnel） 

風暴後的資料收集主要依賴受過訓練的損害評估人員。評估人員可從不同群體

招聘，取決於社區需求： 

社區工作人員 

樹木專業人員 

志工 

 

所有評估人員需接受手動收集資料的訓練。我們強烈建議在風暴前工作期間訓

練，因為在緊急情況下訓練是非常困難的。讓評估人員深度熟悉估計殘骸體

積、勞動時間或成本是不必要的。評估系統的設置即是為了減少對專業經驗的

需求。 

 

志工通常需接受更多訓練、激勵和監督，使任何人在 Storm 資料收集上，皆樂

於使用志工資源。注意：為了安全起見，應小心督促參與風暴後資料收集的志

工。 

 

風暴前和風暴後的調查最好使用相同評估人員。他們應具備下列條件： 

 對樹木和樹木工作具一定程度的熟悉度 

 在緊急情況下的可投入時間 

 本地戶籍 

 

若社區決定使用內部工作人員以建立樣本樣區，並向外承包實際損失評估，進

行風暴後評估的人員，需針對樣區位置、資料輸入和用於評估的協議程序，接

受事前訓練。 

 

備份和存儲（Back-up and storage） 

為風暴後的工作擬定一個彈性的計畫，以有效應對不同狀況。準備好面對辦公

室、停電和交通意外等問題。在緊急事件期間，詳細規劃能減少麻煩： 
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 兩個獨立設置的樣區資訊應受維護且儲存於不同位置。 

 電子設備需隨時可供使用。PDA需保持充電完整，若其使用電池，則需備

好足夠電池。因為災害常會伴隨停電，所以筆記型電腦作為主機會比桌

上型電腦更適合。 

 資料收集的紙製表格應影印出來，且儲備好鉛筆、削鉛筆機和剪貼板。 

 

與相關官方人員溝通結果（Communicating results with the proper officials） 

每個社區的資料彙整需即時傳達給適當的官方人員，使風暴損害評估的努力能

有價值。因此，地方、州和聯邦的聯繫方式應與風暴評估協議的資訊一起歸

檔。可以將聯繫資訊紀錄在〈附錄二〉的表格六。 

 

可以使用預先確定好的報告方式完成風暴後評估資訊的傳輸，例如，電話、傳

真、電子郵件或隔夜郵件。應建立多餘一種方式，因為在大型風暴活動期間，

通信可能會受到干擾而中斷。 

 

前期規劃決策（Early Decisions to Be Made） 

開始執行 Storm 前，需先做出幾個決定。 

 

你預估會有哪些類型的風暴？暴風雪、颶風和水災，或規模較小的災害？

（What kinds of storms do you anticipate? Ice storms, hurricanes and floods, 

smaller-scale disasters?） 

不同災害類型會呈現不同的損害和殘骸分佈，使用 Storm 時，需再做些調整。 

 

暴風雪（Ice Storms）：暴風雪往往會造成較廣泛和一致的損害，殘骸幾乎全是

植物。此外，冰載殘骸通常會保持在其初次著陸的地方，不受自然力量四處移

動。這些特性讓人透過小型隨機樣本快速、精確地估計潛在和實際損害與成

本。 

 

颶風和水災（Hurricanes and floods）：颶風和許多水災也會造成大範圍的破

壞，使 Storm 產出精確的實際損害和成本之快速評估。颶風調整已內建於

Storm 裡，能使用 2004-2005年內的羅里達社區於颶風季節時的 10％隨機樣本

實際資料和作法。針對風暴前評估，颶風調整（測試版）以街道里程數和三個

損害等級為基礎，預測平均植物殘骸負載。因為使用一般平均值，往往針對較

大規模的估計會比局部來得精確。 

 

更多有關估計局部規模的潛在颶風損害估計之詳細方式，U.S. Army Corps of 

Engineers、佛羅里達州布勞沃德郡（Broward County, FL）的 Diana Umpierre 與

Glenn Margoles，及 FEMA 皆參與了開發。關於這些方法的更多細節，也可於 i-

Tree網站（www.itreetools.org）的 Resources 找到。 
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小型災害（Smaller-Scale Disasters）：較小規模的災害，包括龍捲風、derechos

（有關閃電風暴的直線型風暴）和一些水災，會出現採樣問題，因為它們影響

的區域比較小。為了估計較小規模災害引起的損害，可使用以下程序： 

確認災區的粗略地理位置。欲估計災區，可能需要快速評估該區域，例如

從不同方向開車前往該區域，記錄災害開始的地方，或如果可行，利用航

空資料等。 

在街道的地圖或用於採樣的 GIS 檔案上，繪製受影響區域的邊界。 

使用比例尺地圖或標準的 GIS 工具確認受影響區域的總街道里程數。 

建立該區域街道區段的合適樣本。 

 

一旦完成這些調整，即可如下所述，完成暴風前的處理。 

 

颶風調整的使用者還需決定：你會於殘骸移除的估計中分開樹木移除和樹木修

剪的估算嗎？（Hurricane Adaptation users must also decide: Will you separate 

estimates for tree removal and tree pruning from estimates of debris removal?） 

資料收集協議會因你是否會在緊急工作中標出殘骸（包括修剪和移除），或用不

同作法處理緊急樹木修剪和/或移除，而有所差異。 

 

你會在風暴前後，或只在風暴後收集資料？（Will you collect data before and 

after or just after a storm?） 

在風暴前收集資料有幾個優點。首先，你將更熟悉你的樣區──它們的位置、

狀態和參訪它們的最佳途徑。知道這些在風暴後的資料收集上會更容易。其

次，Storm 會提供預期的損害估計，幫助你做災害準備計畫。最後，對於 Storm

（非颶風）版本，暴風前的資料收集可用於改善暴風後估計。 

 

決定將殘骸移除與樹木修剪移除共同估計的颶風調整版本使用者，不需要做暴

風前的實地資料收集來估計損害。對於這些使用者，風暴損害估計利用歷史資

料，並根據城市中街道的單純總里程數及損害的等級估計（高、中、低）。如果

你使用的是颶風調整版本，且會分開樹木修剪移除跟殘骸移除，包含實地資料

收集的暴風前分析也能提供有價值的資訊。 

 

你的社區包含農村（無人居住）的道路嗎？（Does your community include 

rural (unpopulated) roads?） 

農村道路的資料收集和人口密集區域的資料收集略有不同。這主要是因為在人

口密集區域，FEMA會補償居民能托運到路邊的殘骸成本，所以超過 50 英呎的

樹木會優先納入潛在殘骸的估計當中。專為農村區域和農村樣區的手動表格能

由樣區清單和 PDA識別。 
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收集資料，你將會使用（a）i-Tree Storm PDA 工具，（b）手動輸入資料的紙製

表格，或（c）非 i-Tree平台？（Will you collect data using (a) the i-Tree Storm 

PDA tool, (b) paper forms for manual data entry, or (c) a non-i-Tree platform?） 

Storm 的軟體組合包含了用於資料收集的 PDA的應用程序。i-Tree v. 3.0 做出了

重大更新，現在能夠使 PDA的應用從 Storm 中無縫工作。該方案能在 Pocket 

PC 的裝置下，運行的Window’s Mobile 2003（或更高的版本）進行工作。 

 

如果你的團體缺少使用 PDA或行動裝置的經費，或你想使用另一種方法，那也

可以。資料的收集能使用附錄的紙製表格、電子表格進行。如果你使用紙製表

格，資料能在之後直接輸入於 Storm 的 Excel模板中。若欲使用非 i-Tree平

台，請查看表格的資料要求。準備紙製表格是很好的想法，因為風暴可能造成

停電。 

 

收集基本資料（Gathering General Data） 

在 Storm 計算出清理的時間和金錢之前，你需提供關於你社區的幾個特定數

字。 

 

你管理的所有街道的總街道里程數（Total street mileage for all of the roads you 

manage） 

確定在發生緊急情況時，你責任範圍內的所有公用道路總中線里程數。這個數

字是非常重要的。如果該訊息不能立即獲得，可以透過 Geography Network 

（www.geographynetwork.com）GIS 技術人員使用的 TIGER/Line 檔案，免費下

載 shapefiles 檔案。請參考〈附錄一〉的詳細訊息。 

 

透過大小類別估計修剪和移除樹木的所需時間（Estimated times required for 

pruning and removing trees by size class） 

預設值可根據當地條件調整。你可以在下面的工作表中輸入本地數值。 
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估計每立方碼所有殘骸的管理成本（Estimated cost per cubic yard for total debris 

management） 

此值包括託運、還原和最終處理的所有成本。根據 FEMA 2007 Debris 

Management Guide，Public Assistance Program 下的合格殘骸工作需滿足以下條

件： 

 由重大災難事件產生的殘骸。 

 殘骸位於符合資格申請人的財產改善或優先權中所指定的災難區域。 

 殘骸清除是申請人的法律責任。 

欲了解更多訊息，請至：http://www.fema.gov/government/grant/pa/demagde.shtm  

 

估計每小時的樹木移除率（Estimated hourly rate for tree removal） 

確定你的社區移除樹木的每小時預期成本。不區分樹木修剪與殘骸移除的颶風

調整版本使用者應跳過這個問題。 

 

估計每小時的樹木修剪率（Estimated hourly rate for tree pruning） 

確定修剪樹木的每小時預期成本。不區分樹木移除與殘骸移除的颶風調整版本

使用者應跳過這個問題。 

 

創建樣本（Creating a Sample） 

在暴風前後的資料收集開始前，你需在你的社區創建街道區段的隨機樣本。這

可以透過多種方式完成，其中之一在〈附錄一〉有概述。任何採樣方法的關鍵

在於，它需遵守以線性街道區段為基礎的簡單隨機抽樣常規，以提供精確的結

果。 
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我們建議創建以 2％的街道區段為樣本，最少不低於 10個，最大不高於 30個

的樣區。如果損傷程度相對恆定，則損害的估計被證明會落在 5％的真值中。

如有必要，選擇額外的 5個區段作為替代品，也是非常好的想法。 

 

創建樣本時，需仔細包括符合條件的道路，意味著你需排除私人或聯邦道路。 

 

無論使用何種方法創建你的樣本，最後結果應是街道區段的簡單隨機樣本。此

外，你需知道你研究區域內的總線性街道里程數。 

 

加載或手動輸入你的樣本清單到 Storm（Loading or manually entering your 

sample list into Storm） 

若欲使用〈附錄一〉的方法創建你的樣本，你可以直接將其加載到 Storm 中，

以在在手動資料輸入期間節省時間，或在 PDA使用： 

1) 使用你電腦上的開始選單 > 所有應用程式 > i-Tree > Storm > Storm 

Interface。 

2) 點擊 Import from Tiger Line，瀏覽至保存街道區段.dbf檔案的位置，

並點擊 Open。 

1.  

確認樣區清單是否成功建立： 

1) 在介面上點擊 Add/Edit，Plot Lookup Data Entry 視窗將開啟。 

2) 若欲添加更多樣區，點擊 New。若想改變一個樣區或移除它，選取它

並點擊 Edit 或 Delete。 

3) TIGER/Line 檔案不包括兩個你需知道的資訊：ROW 寬度和樣區是否

為農村（無人居住地帶）。這些可以在桌機介面或實地添加。 

4) 完成樣區清單後，點擊 OK關閉視窗。 

 

若欲使用另一種方法創建隨機樣本，介面仍是輸入一般樣區資料到 Storm 裡的

最好方式。在介面上點擊 Add/Edit，再點擊 New，開始手動添加樣區。[請注

意：樣區也可直接手動添加到 Storm 模板，可從電腦的開始選單取用。詳細資

訊請參考〈第二階段〉或〈第三階段〉的〈將資料傳送至桌機〉。] 

 

將你的樣本樣區地圖化（Mapping your sample plots） 

擁有樣本樣區的地圖可大大簡化資料收集。〈附錄一〉提供了使用在 GIS 創建

的 shapefile以創建地圖的說明。若你在 GIS 中使用另一種方法創建隨機區段，

則該 shapefile可疊加研究區域的數位航空照片。若無法取得數位照片或樣本為

手動創建，區段也可使用數位地圖或紙制地圖定位。 

 

PDA的準備（Preparing the PDA） 

在本節中，我們將介紹如何準備使用 PDA收集資料。若你使用紙制表格收集資
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料，你可以直接跳到下一節。 

 

PDA配置將在桌機上進行。欲開始： 

1) 使用你電腦上的開始選單 > 所有應用程式 > i-Tree > Storm > Storm 

Interface，開啟 Storm Interface。 

2) 在先前的步驟中，你應該已使用介面將你的樣區清單加載到 Storm

裡。如果沒有，請點擊 Import from Tiger Line，瀏覽至 TIGER/Line

檔案的儲存位置。點擊 Open。 

3) 欲將樣區清單轉移至 PDA，首先將 PDA連結到你的電腦。你的電腦

必需識別你的 PDA。如果無法自動識別，請依照該設備的說明完成此

步驟。 

4) 在 Storm 介面（Storm Interface）中，點擊 Sync Handheld Device，

Storm PDA Transfer 視窗將開啟。 

5) 你的第一步應是查看需加載哪些軟體到 PDA中。請點擊 Check Status

以查看。如果有任何組件缺失，它們將顯示為紅色，Install 按鈕也會

出現。點擊 Install 按鈕添加必要組件，並按照 PDA螢幕上的指示操

作。 

6) 完成 PDA設置後，點擊 Send Project Configuration to PDA。PDA 應

該已經準備好進行資料收集了。 

 

探索 PDA（Exploring the PDA） 

我們將在下方詳細介紹 PDA應用程式，但現在，先花點時間熟悉一下它的運作

方式。欲開啟應用程式，先從 PDA的程式（Program）選單中，選擇 i-Tree 

Storm。在 Storm 的主選單中，點擊 Next即可開始下一步。所開啟的視窗將允

許你 Add Plots（新增樣區）、Review Plots（檢視樣區）和 Delete Plots（刪除

樣區）。 

 

Add Plots（新增樣區）是 PDA應用程式的核心。前三個視窗讓你在樣區上輸

入（或從下拉式列表選擇）一般資料。輸入完樣區資料後，你可選擇 PreStorm 

Tallies或 PostStorm Tallies。PreStorm Tallies 允許你在 ROW 上計算樹木。勾

選任何方框皆能增加計數。透過切換 Add 按鈕並勾選想要的方框，可以減少或

移除一棵樹。PostStorm Tallies 允許你統計需被移除或修剪的樹木，其包括一

個額外視窗用於輸入需移除的殘骸。探索完後，點擊 Back 和 Abort回到主視

窗。 

 

Review Plots 介面提供所有樣區的清單。你可以點選其中一個並點擊 Edit 更

改。Delete Plots介面同樣提供所有樣區的清單。欲刪除任一條目，從列表選擇

它，接著點擊 Delete。 
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紙制表格的準備（Preparing Paper Forms） 

〈附錄二〉（暴風版本）的表一或〈附錄三〉（颶風調整）是所有樣區的主選

單。傳送你的樣本清單到表一，包含樣區數目和樣區長度。如有需要，使用更

多表單。總結所有樣區的總長度。填寫你的社區的總街道英里數（Total Street 

Miles）和計算街道英里百分比（Percent Street Miles）。 

 

若你將收集暴風前的資料，你需要替每個樣區準備一份表二的副本。針對適用

的版本準備足夠副本（如風暴或颶風； A：居住地區，B：農村地區）以涵蓋

所有樣本街道區段。 

 

如果你將收集暴風後的資料，你需要替每個樣區準備一份表四的副本。針對適

用的版本準備足夠副本（如風暴或颶風； A：居住地區，B：農村地區）以涵

蓋所有樣本街道區段。 

 

清單（Checklist） 

在〈第一階段：準備〉的最後，你應已準備好以下項目： 

 列印隨機樣本樣區的清單 

 列印樣本樣區的地圖 

 PDA裝載樣本樣區清單 OR。 

 所有樣區皆填寫完成的表一和足夠的表二副本（暴風前的資料收集）或表

四副本（暴風後的資料收集）以涵蓋所有樣區。 

 

為了準備在風暴過後能立即收集資料，這些項目應收納於某個安全的地方，並

應備妥副本，保留在不同位置。 
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第二階段：暴風前（Phase II: Before the Storm） 

 

準備資料收集（Preparing for Data Collection） 

PDAs 

如果你將使用 PDA收集資料，在第一階段中，你應該已加載你的隨機樣本區段

到你的 PDA。如果沒有，現在回到那些步驟並仔細操作。 

 

紙製表格（Paper forms） 

如果你在第一階段間使用紙制表格收集資料，你應該已完成了表格一、所有樣

區的主要清單，以及樣本街道區段足夠的表二（如風暴或颶風； A：居住地

區，B：農村地區）適當版本的副本。如果沒有，現在這樣做。 

 

工具（Tools） 

前往實地前，你需要以下設備： 

 樣本樣區的地圖。 

 樣本樣區資訊的表格，包括數目、開始和結束、街道名稱和長度 

 Biltmore stick 或 DBH 膠帶，用於測量 DBH 或目測估算 

 手動資料收集工具 

o 表一用於追蹤訪問過的所有樣區 

o 各樣的表二區副本 

o 剪貼版 

o 鉛筆（最好）或筆 

 PDA，配置完成並已裝載樣本樣區 

o PDA保護殼，以繩掛為首選 

o 備用電池、電池組合或行動裝置充電器 

o 額外的手寫筆 

 

暴風前的資料收集（Data Collection Before the Storm） 

欲開始暴風前的區域調查，在地圖上找到第一個街道區段的位置，並前往該區

域。 

 

測量什麼（What to measure） 

在每個街道區段，你的目標是計算各 DBH 6 英吋等級的樹木數量（DBH 測量

可以用 Biltmore stick、DBH膠帶，或目測搭配偶爾的檢查以確認其精確度）。

請記住以下限制： 

 只能計算還活著的樹木。 

 只能計算 DBH ≥ 6 英吋的樹木。 

 計算街道兩側與中央（若存在）的樹木。 
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 在農村（無人居住）區域，計算在公共優先權（right-of-way，ROW）的樹

木。 

 在人口密集區域，計算 ROW 中和 ROW 內 50英呎的樹木（獨立追蹤它

們）。 

 如果有棵樹木在 ROW邊緣，如果適用，按照當地規範確定它是否為一棵

公共樹。如有需要，目測樹幹的中間點位置，若樹幹的一半落入該區

域，計算它。 

 

請注意：如果不清楚精確的 ROW，基於人行道的位置、公共事業、圍牆等，利

用你的實地判斷計算它的邊界。 

 

不需收集任何物種和條件的資料。調查的目的僅是確認任何需移除或修剪的樹

木，或是經吹拂可能掉落，又或是在暴風後被拖入 ROW 的樹木。 

 

測量什麼：颶風調整（What to measure: Hurricane Adaptation） 

如果你正在使用颶風調整，且決定在先前的第一階段中，從所有殘骸獨立追蹤

樹木移除/修剪，按照上述指引清點樹木，但只能計算 ROW 中的樹木。 

 

請注意：若你使用颶風調整版本，且你不分開追蹤殘骸收集與樹木移除/修剪，

你便不需執行風暴前的資料收集。你可以直接跳到資料分析。 

 

手動收集資料（Data collection using manual forms） 

針對各樣區，選擇表二的相應版本（如風暴或颶風； A：居住地區，B：農村

地區）。填寫標題訊息，包含地址資料、日期、樣區長度和 ROW 寬度。如果樣

區不是典型城市街區，描述樣區的開始和結束。 

 

表二的主要部份允許你使用刻度標記各大小等級的樹木，並在最後結算它們。

簡單地走上街道區段的一邊和走下另外一邊，在「Tally」欄位中標記每棵樹木

的大小類別﹝如果可以，分開 ROW 內和 ROW 外（ROW + 50）的樹木﹞。完

成該區段後，計算你的刻度標記數量，在下一欄位內寫下數字。 

 

使用 Storm 模板時，表二的其餘區域會自動計算。如有必要，依循表格下方的

說明，它們也可手動計算。 

 

使用 PDA收集資料（Data collection using the PDA） 

欲使用 PDA開始收集資料： 

1) 從 PDA中的應用程式（Programs）選單選擇 i-Tree Storm。 

2) 在主視窗點擊 Next，準備開始。 

3) 點擊 Add Plot，輸入 Community name，從下拉式選單中選取一個樣
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區。欲添加不在清單上的樣區，直接填寫下方欄位。點擊 Next。 

4) 輸入 ROW width（ROW 寬度），再於 Collected By 下輸入你的名字或

名字縮寫，點擊 Next。 

5) 如果區塊非典型市區，輸入樣區開始與結束的描述。 

6) 點擊 PreStorm Tallies，開始計算樹木。 

a) 走上街道區段的一側，並從另一邊走下，勾選適當大小等級的

方框，將樹木添加至 ROW 中。 

b) 如果你犯了一個錯誤，需要移除樹木，點擊 Add/Subtract

鈕，切換至減除，接著點擊刪除。 

c) ROW 樹木添加完成後，如果沒有問題，點擊 Next，針對 Off 

ROW 樹木重複以上步驟。 

7) 完成後，點擊 Save Tallies保存你的資料。 

8) 回到主選單繼續添加樣區。 

 

存檔後，若你需要編輯一個樣區，在主選單中點擊 Review Plots，選擇要編輯

的樣區，點擊 Edit 進行變更。 

 

將資料傳送到桌機（Transferring Data to the Desktop） 

PDAs 

從你的 PDA傳送 PDA 收集的普查資料到你的桌機上： 

1) 連接 PDA到你的電腦。 

2) 在你的電腦中的開始選單，打開 Storm PDA Interface。 

3) 點擊 Sync Handheld Device，選擇 Retrieve Data from PDA。 

4) 點擊 OK關閉視窗。你的普查資料已上傳到 Storm。 

5) 點擊 Export Data to Spreadsheets。 

6) The Community Values 視窗將開啟，讓你輸入在〈第一階段：準備〉

時確定的數值。輸入當地成本和預估時間後，點擊 OK。 

7) Save File視窗將開啟，瀏覽至欲儲存檔案的位置，替你的專案檔案命

名，點擊 Save。你的檔案將保存到 Storm 模板（Excel 文件）。 

8) 執行 Excel 並開啟你在上一步驟中創建的檔案。同意 Enable macros。 

 

紙製表格（Paper） 

從紙制表格轉傳資料到 Storm： 

1) 在你的電腦的開始選單中，打開 Storm PDA Interface。 

2) 在〈第一階段：準備〉時，你應該已加載或手動輸入你樣的區名單到

Storm Interface 中。如果沒有，現在進行此步驟，點擊 Import from 

Tiger，瀏覽至樣本樣區的.dbf檔案，或點擊 Add/Edit 手動輸入樣區資

料。 

3) 添加完所有樣區後，點擊 Export Data to Spreadsheets。 
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4) The Community Values 視窗將開啟，讓你輸入在〈第一階段：準備〉

時確定的數值。輸入當地成本和預估時間後，點擊 OK。 

5) Save File視窗將開啟，瀏覽至欲儲存檔案的位置，替你的專案檔案命

名，點擊 Save。你的檔案將保存到 Storm 模板（Excel 文件）。 

6) 執行 Excel 並開啟你在上一步驟中創建的檔案。同意 Enable macros。 

7) 在主螢幕上，從 Select Analysis 下拉式選單中選擇暴風（Storm）或颶

風（Hurricane）。 

8) 現在，跳過主螢幕上的剩餘問題，點擊 Excel 底部的 PreData tab。 

9) 每一行包含一個樣本樣區的資料。在模板上，將樣區編號與表二副本

的樣區匹配，接著將表二的主選框中的資料傳輸到電子表單上的合適

區塊。 

a) 若有需要，你可以透過選擇最上面一行的所有區塊（通常為

O1: AB1），再於 Excel 主要工具列中，點擊 Data > Form，在

Excel 上創建一個輸入表格，使資料輸入更加方便。點擊 Tab

鍵在欄位間移動，點擊 Enter鍵移動到一個新的紀錄。 

b) 請記得經常儲存你的工作進度。 

 

資料分析（Data Analysis） 

設置問題（Set-up questions） 

當你的資料手動或使用 PDA介面輸入完畢後，你即可開始資料分析。如有必

要，可以透過先前步驟中儲存的 Excel 檔案，開啟 Storm 模板。同意 Enable 

macros。 

 

如果你使用颶風調整，就不需收集暴風前的資料，因為你將修剪和移除一起算

入殘骸收集裡。在這個步驟中，你可以從你電腦開始選單中開啟 Storm 模板，

重新命名並另存在你想要的位置上。 

 

確認上方的分析選項（暴風與颶風）是正確的。與當地成本和時間估算有關的

問題 1-4和最後問題（5為颶風，8為暴風）的答案，應照你輸入至介面的資料

填寫。如果沒有，或你想進行更改，根據你在〈第一階段：準備〉所收集到的

資訊回答問題。 

 

颶風調整的問題 5詢問你想使用的殘骸率。這個選擇只影響風暴前的計算，和

風暴預期嚴重程度有關。你可以在三個值之間切換，並觀察結果如何變化。欲

開始，請保留預設中間值。 

 

若你使用的是暴風版本（非颶風），你可以對問題 5-7提供更多資訊，或你也可

以將它們標記為「Unknown（未知）」。對這些問題的回答有助於確定結果的精

確度。 
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問題 5：你的樹木密度號碼的來源是什麼？Storm 利用樹木密度的平均值估計被

製造的粗材殘骸量，無論是針對暴風前的估計，或為了將樹冠缺失量轉化成殘

骸的立方碼。預設值來自下表a： 

 

 
 

對於高階的使用者，預設值可在 Storm Excel模板的 Codes tab 下進行調整。若

你改變數值，針對問題 5選擇一個最能描述你的方法的回答。對大多數的用戶

來說，他們都會想保留預設值。 

 

問題 6：你用什麼抽樣方法？從下拉選單選擇最合適的答案。 

 

問題 7：你是如何得到你的暴風前資訊？對暴風前資料分析留下未知

（unknown）。 

 

報告（Reports） 

回答所有問題後，點擊 PreAnalysis 標籤查看你的暴風前估計。灰色框包含你在

主螢幕上輸入的資訊。樹木的號碼是從 PreData所編碼。重要的數值──勞動

時間、總成本和全部殘骸──都在右上角。最重要的數字，重大暴風損害的暴

風前預估，顯示於最上方的紫色方框。 

 

列印（Printing） 

在 Excel 工具欄裡，點擊檔案（File）> 列印（Print）。報告已設定好將列印最

重要的資訊：結果、移除（Removals），以及危險修剪的計算。 

 

                                                 
a 關於如何創建此表的更多資訊，請參考 i-Tree 網站（www.itreetools.org）的 Resources 的

〈An Initial Storm Damage Assessment Protocol for Urban and Community Forests〉。 
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第三階段：暴風後(Phase III: After the Storm) 

一旦風暴安全通過，資料收集應盡快開始，且應在風暴結束後的 12小時內完

成。 

 

準備資料收集（Preparing for Data Collection） 

PDAs 

如果你將使用 PDAs 收集資料，在第一階段你應已加載你的隨機樣本區段到你

的 PDA了。如果沒有，現在回到那些步驟並開始處理。 

 

紙製表格（Paper forms） 

在第一階段，你應該已完成了表一、你所有樣區的主列表，並已準備足夠相容

版本的表格三之副本以用於你所有的樣本街道區段（如，A：居住區域、B：鄉

村區域；颶風或暴風）。如果沒有，現在開始進行。 

 

工具（Tools） 

前往實地前，你需要以下設備： 

 樣本樣區的地圖。 

 樣本樣區資訊的表格，包括數目、開始和結束、街道名稱和長度 

 Biltmore stick 或 DBH 膠帶，用於測量 DBH 或目測估算 

 手動資料收集工具 

o 表一用於追蹤訪問過的所有樣區 

o 各樣的表二區副本 

o 剪貼版 

o 鉛筆（最好）或筆 

 PDA，配置完成並已裝載樣本樣區 

o PDA保護殼，以繩掛為首選 

o 備用電池、電池組合或行動裝置充電器 

o 額外的手寫筆 

 

安全（Safety） 

在都市環境中收集資料時，安全總在考量之內，都市環境標準預防措施應被採

用。當然，在風暴過後，資料收集的風險更大，因為 Storm 程序需在風暴通過

後的 12 小時內調查樣本樣區。透過手機、雙向無線電或其它方法，與當地風暴

中心或危機協調員建立可靠的聯絡方式，以及一台可依賴的車子（在冬天風暴

情況下需有四輪驅動）為宜。 

 

大災害等級的風暴往往會產生危險的狀況。危險的樹木及樹木部分可能威脅道

路與人行道。這些包括樹冠上的大型懸掛物體、已經不穩定的整棵樹木以及地
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面上的大量殘骸。此外，被放低或被擊落的電線常會落在與人容易接觸的地

方。由於它們經常還有作用，風暴過後的資料收集者需警戒並遠離它們。與當

地公共事業官員的仔細協調將有助於降低資料收集者的風險。 

 

請注意：你應遵照先前規劃的樣區之間的有效路徑，但當規劃的路線被阻礙

時，也要準備好使用其他路線。移動可能會被殘骸或擊落的電線所限制，使得

進行調查變得困難與危險。要對危險有所警覺。這裡詳述的收集方法可能在一

些樣區上會有修改以保障安全。無論何時進行修改，都應謹慎進行，並盡可能

維持資料品質，讓最後的估算有一定準確度。 

 

暴風後的資料收集（Data Collection After the Storm） 

首先，在地圖上確定第一個街道區段（樣本樣區），之後前往該地。 

 

測量什麼（What to measure） 

在風暴過後的資料收集中，有三個關鍵資訊需被記錄（針對颶風調整，你可能

已決定將這些分於同一組中）： 

 需移除的樹木的數量及大小。 

 需修剪以移除危險樹枝的樹木的數量與大小。 

 生成的殘骸量 

 

需移除的 ROW樹木：在 ROW 中計算樹木數目及大小，包括以下： 

 樹木部分倒下（例如樹木部分被連根拔起或靠在其它樹木上）。如果樹木有

任何部份落於或可能倒塌到 ROW 範圍內，此樹應被計數。 

 樹冠有明顯損傷（失去 50%或更多樹冠），但仍屹立不倒的樹木也包含在移

除內，因為 FEMA 將允許這些費用。不過良好的判斷標準也應被執行。

研究和經驗表示一些品種針對其失去的大量樹冠恢復得十分良好，健

康、年輕的樹木有很好的恢復機會，且距離主幹樹冠越遠的失去對樹木

的威脅越小。 

 不包含已完全倒在地面的樹木。這些應作為殘骸估計移除。 

 只有 ROW 樹木應包含在內。 

 

請注意：如果無法得知準確的 ROW，根據實地狀況判斷，像是人行道、公共設

施、柵欄的位置等，以估計其邊界。 

 

需修剪以移除危險樹枝的 ROW樹木：記錄有破碎或懸掛樹枝的樹木的數量及

大小，其樹枝直徑是兩吋或更大，且仍在樹木的樹冠上。請注意，危險修剪會

僅限移除懸掛或破碎的樹枝。額外的修剪如修正撕開的樹枝或將破碎的樹枝適

當修剪並不包含在內。只有 ROW 樹木應被包括在內。 
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產生的殘骸量：紀錄 ROW 內的生成且需移除之殘骸量（針對居住區域，與

ROW 距 50英呎的區域也算在內）。這可以兩種方法計算： 

 

樹冠損失：針對你行道區段的每 100英呎，估計所有 DBH ≥ 6英吋且位於

ROW 內的樹木樹冠損失量（針對居住區域，與 ROW 距 50英呎的區域也

算在內）。估計應為 25%階級的中點，即為 12.5%（0-25%樹冠損失）、

37.5%（26-50%樹冠損失）、62.5%（51-75%樹冠損失）或 87.5%（76-100%

樹冠損失）。有關更多估計樹冠損失的資訊，請參考 i-Tree網站

（www.itreetools.org）的 Resources 內的相關文件。 

 

請注意：如果結構以及拆卸的殘骸還存在，此樹冠損失選項不能用於估計殘

骸。因此，此種方法不適用於颶風調整。 

 

立方碼（Cubic yards）：針對你行道區段的每 100英呎，估計 ROW 內的實

際殘骸體積（針對居住區域，與 ROW 距 50英呎的區域也算在內）： 

想像一個裝入殘骸的箱子。如果是零散的，把它們想像在一起。 

以英呎估計箱子的長度、寬度以及高度。 

將這些尺寸相乘並除以 27以轉換到立方碼。 

例如：一個典型的 100英呎延伸可能有 50英呎的 ROW 到任一側的中

線，並完全被殘骸覆蓋到高 2英呎，使該公式： 

100 ft（長）x 200 ft（寬）x 2 ft（高）= 40,000 ft3 ÷ 27 = 1,480 yds3 

 

測量什麼：颶風調整(What to measure：Hurricane Adaptation) 

如果你使用 Storm 的颶風調整版本，你收集的資料取決於你是否決定分開估計

樹木移除修剪及殘骸的成本。如果你分開估計移除修剪，只要遵照上方的指示

並且確定使用立方碼方法計算殘骸量。 

 

如果你合併計算移除修剪和殘骸，遵照上方的立方碼方法的指示，計算殘骸的

移除。 

 

手動收集資料（Data collection using manual forms） 

針對各樣區，請選擇適合樣區類型的表格四版本（A：居住區域，B：鄉村區

域；颶風或暴風）。填寫標題資訊，包括地址資料、日期、樣區長度及 ROW 寬

度。如果樣區非完整街區，請描述樣區的啟始與末端。 

 

表格四的主要部分允許你使用刻度標記各大小等級的樹木，並在最後結算它

們。簡單地走上街道區段的一邊和走下另外一邊，在「Tally」欄位中標記每棵

需移除與需修剪的 ROW 樹木的大小類別。完成該區段後，計算你的刻度標記

數量，在下一欄位內寫下數字。接著，使用樹冠損失或立方碼方法估算每延伸
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100英呎需移除的殘骸量，並在最後兩欄輸入數值。如果有個區段的延伸超過 8

個 100英呎，則估算剩餘的每 100英呎區段平均值，並在「額外（Extra）」欄

位輸入。 

 

表格四的剩餘項目，包括總合與平均數，將自動使用 Storm 模板計算。如有需

要，它們也可手動計算，只要遵照表格底部的指示。 

 

使用 PDA收集資料（Data collection using the PDA） 

欲使用 PDA開始收集資料： 

1) 從你的 PDA程式（Program）選單選擇 i-Tree Storm。 

2) 在主視窗中點擊 Next 以開始執行。 

3) 點擊 Add Plot，輸入 Community name 並從下拉式清單中選擇樣區。欲

添加不在清單上的樣區，直接填寫下方欄位。 

4) 點擊 Next。輸入 ROW width（寬度），在 Collected By 輸入你的名字或

名字縮寫。點擊 Next。 

5) 如果此區段非完整街區，請描述此樣區的開始與結束。 

6) 點擊 Post Storm Tallies 開始計算樹木。第一個視窗是需修剪的相符樹

木。簡單地走上街道區段的一邊和走下另外一邊，在適當的大小類別中

點擊欄位以計算需要修剪的 ROW 樹木。如果你犯了一個錯誤且需刪除

樹木，點擊 Add/Subtract 按鈕，切換到減少，再點擊刪除。 

7) 一旦需修剪的樹木已被添加，點擊 Next進入到危險移除（Hazard 

Removal）視窗，計算需移除的樹木。 

8) 最後，點擊 Next估計殘骸移除。你可以藉由點擊上方的按鈕以在立方碼

與百分比樹冠損失間切換。 

9) 完成後，點擊 Next與 Save Tallies 以儲存你的資料。 

10) 回到主要選單繼續添加樣區。 

 

如需編輯已儲存的樣區，在主選單中點擊 Review Plots，選擇欲編輯的樣區，

點擊 Edit 以進行變更。 

 

將資料傳送到桌機（Transferring Data to the Desktop） 

PDAs 

欲將你使用 PDA收集的普查資料傳送到你的桌機： 

1) 將 PDA連接到電腦。 

2) 從你電腦的開始選單中開啟 Storm 的 PDA介面。 

3) 點擊 Sync Handheld Device，再點擊 Retrieve Data from PDA。 

4) 點擊 OK以關閉視窗。你的普查資料現在已經上傳到 Storm 了。 

5) 點擊 Export Data to Spreadsheets。 

6) The Community Values 視窗將開啟，允許你輸入你在〈第一階段：準
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備〉時所確定的數值。輸入完你的當地成本與估算時間後，點擊 OK。 

7) Save File視窗將開啟。瀏覽至你想要儲存檔案的地方，命名專案後，點

擊 Save。你的資料已經保存到 Storm 模板了（一個 Excel 文件）。 

8) 開啟 Excel 並開啟你在上一步所建立的文件。同意 Enable macros。 

 

紙製表格（Paper） 

從紙制表格轉傳資料到 Storm： 

1) 在你的電腦的開始選單中，打開 Storm PDA Interface。 

2) 在〈第一階段：準備〉時，你應該已加載或手動輸入你樣的區名單到

Storm Interface 中。如果沒有，現在進行此步驟，點擊 Import from 

Tiger，瀏覽至樣本樣區的.dbf檔案，或點擊 Add/Edit 手動輸入樣區資

料。 

3) 添加完所有樣區後，點擊 Export Data to Spreadsheets。 

4) The Community Values 視窗將開啟，讓你輸入在〈第一階段：準備〉

時確定的數值。輸入當地成本和預估時間後，點擊 OK。 

5) Save File視窗將開啟，瀏覽至欲儲存檔案的位置，替你的專案檔案命

名，點擊 Save。你的檔案將保存到 Storm 模板（Excel 文件）。 

6) 執行 Excel 並開啟你在上一步驟中創建的檔案。同意 Enable macros。 

7) 在主螢幕上，從 Select Analysis 下拉式選單中選擇暴風（Storm）或颶

風（Hurricane）。 

8) 現在，跳過主螢幕上的剩餘問題，點擊 Excel 底部的 PreData tab。 

9) 每一行包含一個樣本樣區的資料。在模板上，將樣區編號與表四副本

的樣區匹配，接著將表四的主選框中的資料傳輸到電子表單上的合適

區塊。 

a) 欄位 A-O應會自動填入，使用你輸入的樣區資訊或上傳到

Storm 介面的資訊。 

b) 欄位 P-V標記為 HzPrnXX，XX代表不同的大小類別，在每個

類別填進需要危險修剪的樹木數量。 

c) 欄位 W-AC 標記為 RemvXX，在每個大小類別填進需移除的樹

木數量。 

d) 欄位 AD會標記 CY，如果你使用立方碼測量殘骸，輸入 Y，

若你使用樹冠損失方法，輸入 N。 

e) 儘管欄位 AE-AV標記為 CanopyLoss，它們應被用於輸入殘骸

估計，使用任一方法（樹冠損失或立方碼）。在每個欄位輸入

各 100 英呎區段的殘骸量。如果你在表格三的額外欄位有數

值，使用 AN（CanopyLoss10）。 

f) 欄位 AO及 AP（AvgCanopyLoss 與 Cytotal）將自動計算。 

g) 你可以在 Excel 中建立一個輸入格式使資料輸入更加容易，選

擇所有需要的欄位的第一行（通常為 P1: AN1）選擇，並在
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Excel 的主要工具列中點擊 Data > Form。點擊 Tab 鍵以在欄

位間移動，點擊 Enter鍵以移動到新紀錄。 

h) 請記得經常儲存你的工作進度。 

 

資料分析（Data Analysis） 

設置問題（Set-up questions） 

當你的資料手動或使用 PDA介面輸入完畢後，你即可開始資料分析。 

 

如果你仍遵照著這些指示，你應在 Storm Excel 模板中了。如果沒有，請開啟你

在在上一步驟儲存的 Excel 檔案。確認上方的分析選項（暴風與颶風）是正確

的。 

 

與當地成本和時間估算有關的問題 1-4和最後問題（5為颶風，8為暴風）的答

案，應照你輸入至介面的資料填寫。如果沒有，或你想進行更改，根據你在

〈第一階段：準備〉所收集到的資訊回答問題。 

 

颶風調整的問題 5詢問你想使用的殘骸率。這個選擇只影響風暴前的計算，和

風暴預期嚴重程度有關。 

 

若你使用的是暴風版本（非颶風），你可以對問題 5-7提供更多資訊，或你也可

以將它們標記為「Unknown（未知）」。 

 

問題 5：你的樹木密度號碼的來源是什麼？Storm利用樹木密度的平均值估

計被製造的粗材殘骸量，無論是針對暴風前的估計，或為了將樹冠缺失量

轉化成殘骸的立方碼。預設值來自下表a： 

 

 

                                                 
a 關於如何創建此表的更多資訊，請參考 i-Tree網站（www.itreetools.org）的 Resources的

〈An Initial Storm Damage Assessment Protocol for Urban and Community Forests〉。  
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對於高階的使用者，預設值可在 Storm Excel模板的 Codes tab 下進行調整。若

你改變數值，針對問題 5選擇一個最能描述你的方法的回答。對大多數的用戶

來說，他們都會想保留預設值。 

 

問題 6：你用什麼抽樣方法？從下拉選單選擇最合適的答案。 

 

問題 7：你如何得到你的風暴後資訊？從下拉式清單中選擇最適合的答案。 

 

完全手動選項（Completely Manual Option） 

在某些情況下，由於停電或難以到達，你可能無法完全使用你的電腦。在這種

情況下，你可以使用表格三及六手動計算，遵照在每頁底部的指示。 

 

報告（Reports） 

回答所有問題後，點擊 PostAnalysis 標籤查看你的暴風前估計。灰色框包含你

在主螢幕上輸入的資訊。樹木的號碼是從 PostData所編碼。重要的數值──勞

動時間、總成本和全部殘骸──都在右上角。最重要的數字，重大暴風損害的

成本預估，顯示於最上方的黃色方框。 

 

列印（Printing） 

在 Excel 的工具欄中，點擊檔案（File）> 列印（Print）。此報告將設置為列印

最重要的訊息：結果、移除與危險修剪計算。 
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附錄一：隨機樣本工具書（Appendix 1: Random 

Sample Workbook） 

以下指示將幫助任何專業程度的人員創建隨機 i-Tree Storm 樣本街段，用於實地

資料收集。ESRI ArcGIS 軟體將被使用（只需些微調整的操作指示與 ArcGIS v. 

8相容）舉例來說，美國人口普查的 TIGER 地圖資料被應用於整個城市。如欲

使用於單一城市區域，請遵循各區域的基本指示。 

 

這些指示由兩個基本步驟組成： 

1) 準備專案區域資料。 

2) 產生樣本街段。 

 

完成上述步驟後，你已創建了下列： 

 關注區域的多邊形（polygon）地圖圖層 

 隨機街段線性（line）地圖圖層 

 

提示： 

 這些指令需在 ArcView 級別下使用 ArcGIS 的基本功能。無須使用任何擴

充軟件。 

 進階 GIS 使用者可主要關注下方列點條列的準備步驟概觀，特別注意區域

名稱與類型等區域的細節指示。 

 對於擁有 Spatial Analyst 的進階 GIS 使用者：疊加 AOI區域圖層以裁切

AOI邊界的街道。針對區域為基礎的分析，在創建一個隨機樣本街段的

圖層後，將之與一個區域多邊形圖層組合，以將街段依區域邊界分割。 

 若有需要，從地圖記錄提供者取得投影/座標系統與地圖單位資訊。 

 AOI樣本為大型多邊形，如城市邊界、公園區域或者是個別管理區。 

 ESRI shapefiles、覆蓋或地理普查皆可使用。Shapefiles 非常容易上手。 

 建立良好的資料管理習慣：放置原始資料的資料夾、放置匯出資料的資料

夾、有邏輯地命名資料夾等。 

 定期地在完成步驟期間，將你的作業保存為 ArcGIS *.mxd 專案。 

 下載資料時，你可能需關閉網頁瀏覽器中的彈跳視窗。 

 

常用工具（Common tools）： 

 

開啟項目（Open Project） 

 

選取（Select） 
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添加資料（Add Data） 

 

 

專案區域資料準備（Project Data Preparation） 

概觀（Overview）： 

 取得可呈現你專案的多邊形關注區域（AOI）的 GIS 地圖圖層。 

 取得可呈現你專案的街道中心線的 GIS 地圖圖層。 

 在 ArcView、ArcEditor 或 ArcInfo級別下啟動 ArcGIS 中的 ArcMap 應用程

式。 

 保存一個*.mxd 專案檔案，並選擇名稱和檔案位置。 

 加載 AOI和街道地圖圖層到視圖中。 

 如有需要，選擇最能代表你專案區域的特定多邊形 AOI。 

 匯出選定的多邊形 AOI。 

 如有需要，選擇（或剪下）你 AOI中的街道線。 

 匯出所選擇的街道線。 

 

結果（Results） 

 由一個或多個多邊形組成的 AOI地圖圖層。 

 相關街道線地圖圖層。 

 

 

詳細說明（Detailed instructions） 

1) 從你的 GIS 部門或是線上資源網，例如 ESRI’s 地理網

（www.geographynetwork.com/）取得你的 AOI多邊形： 

a) 欲取得美國普查 TIGER 地圖資料，於網路瀏覽器瀏覽到

Geography Network。你可能需要在你的網路瀏覽器關閉任何

的彈出窗口。 

b) 在 Featured Content 下選擇 Census TIGER/2000。 

c) 點擊 TIGER/Line Files, Redistricting Census 2000。 

d) 選擇 Preview 及 Download。 

e) 在 Select a State 下選擇你的州別；點擊 Submit Selection。 

f) 在 Select by County 下選擇你的郡縣；點擊 Submit 

Selection。 

g) 在 Available Data Layers 下，勾選以下兩個文件旁的選框

（box）： 

Designated Places 2000 

Line Features – Roads 

h) 選擇 Proceed to Download；選擇 Download File。 
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i) 將文件保存到磁碟並解壓縮到你的工作目錄或是其它位置，使

你可以輕鬆找到。 

2) 在 ArcView（或 ArcEditor或 ArcInfo）等級下啟動 ESRI’s ArcMap 應用

程式。 

3) 使用 Add Data 瀏覽並加載 TIGER Designated Places 以及 Line Features 

– Roads 地圖層到當前視圖。如果出現一個「未知空間參考（Unknown 

Spatial Reference）」訊息，請點擊 OK以前往下一步。 

4) TIGER Designated Places 資料通常是由縣組織並經常包括多個地點多邊

形。在螢幕上使用 Select工具，選擇你的特定 AOI多邊形。如有需要，

細讀屬性表或使用特色標籤（Feature labeling）功能幫助你辨識 AOI多

邊形。 

5) 輸出選擇的 AOI多邊形到一個分離的地圖層，並添加輸出層到視圖中： 

a) 在 TIGER Designated Places 地圖層上點擊右鍵，選擇 Data > 

Export Data 

 

 
 

b) 確認 Export下拉式選單已設置到 Selected features。 

c) 為 AOI多邊形地圖命名並儲存。 

d) 系統提示時，點擊 Yes 以將輸出資料作為一個地圖層添加到視

圖中。 

6) 查詢 TIGER Road Lines 地圖圖層以選擇適合的街道區段為樣本： 

a) 在 Table of Contents（TOC）地圖圖層清單中，點擊 Road 

Lines 地圖圖層以選擇它（確認該地圖圖層也在 TOC 中被選取
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且因此可見於地圖中）。 

b) 從主要工具列中，選擇 Selection > Select by Attributes。 

 

 
 

c) 在開啟的對話視窗中： 

確認 Road Lines 已在下拉式選單中被選擇 

確認所選擇的方法是設置為 Create new selection 

在視窗底部的查詢框內複製貼上已下查詢資訊： 

(“CFCC” = ‘A21’) 

(“CFCC” = ‘A25’) 

(“CFCC” = ‘A31’) 

(“CFCC” = ‘A35’) 

(“CFCC” = ‘A41’) 

(“CFCC” = ‘A45’) 

 

 
 

7) 在選擇的街道上執行額外的查詢，以確定那些在輸出的 AOI內： 

a) 在 Table of Contents（TOC）地圖圖層清單中，點擊 Road 

Lines 地圖圖層以選擇它（確認該地圖圖層也在 TOC 中被選取
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且因此可見於地圖中）。 

b) 從主要工具列中，選擇 Selection > Select by Location，在之後

開啟的視窗中： 

在 I want to 的下拉式選框中，選擇 select from the 

currently selected features in。 

確定只有 TIGER Road Lines 圖層在 the following 

layer(s)清單中被選取。 

在 that下拉式選框中，選擇 are within （選項

completely within 不適用此操作）。 

確定之前匯出的 AOI多邊形層在 the features in this 

layer下拉式選框中被選取。 

不要緩衝（buffer）AOI多邊形。 

點擊 OK。 

 

 
 

8) 匯出所選的 TIGER Road Lines 之子集到一個分開的地圖圖層，並添加此

圖層到視圖中： 

a) 在 TIGER Roads Lines 地圖圖層上點擊右鍵，選擇 Data > 

Export Data。 
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b) 確認 Export下拉式選單已設置到 Selected features。 

c) 為選擇的 streets line地圖層命名並儲存。 

d) 當系統提示時，點擊 Yes 並將匯出資料作為一個地圖圖層添加

到視圖中。 

從主要工具列中，選擇 Selection > Clear Selected Features 以取消選擇 AOI多

邊形和街道特色（Streets features）。 

 

 
 

 

結果（Results） 

AOI 多邊形地圖圖層，以及相關的、適合作為樣本的 AOI街道線性圖層。 

 確認 AOI多邊形和街道地圖圖層已加載到地圖視圖中。可能需要在新 AOI

圖層點擊右鍵並選擇 Zoom to Layer。 

 在地圖層清單中右鍵點擊新 AOI圖層的名稱，選擇 Open Attribute Table

以確認使用屬性欄位（例如「名稱」）的是正確的 AOI多邊形。 

 確認 street lines 沒有延伸並通過 AOI多邊形。 

 

 
 

這條 street lines 現在已經準備好採樣了。 

 

 

生成街道區段樣本（Street Segment Sample Generation） 
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概觀（Overview） 

 添加一個區域到街道資料裡。 

 計算街道資料的隨機數目數值。 

 從屬性欄選取期望的街道區段樣本數目。 

 匯出街道樣本資料和地圖。 

 

結果（Results） 

 供實地採樣的隨機街道區段。 

 

 

詳細說明（Detailed instructions） 

1) 在裁切過的 Streets 地圖圖層中，右鍵點擊 TOC中的 layer name開啟表

格。 

2) 使用表格視窗左上角的 Options 按鈕，添加一個 Double類型、名為

RandomSeg 的欄位至裁切完成的 Streets 表格。將 Precision 和 Scale 欄位

留空。 

 

 
 

3) 右鍵點擊新建的 RandomSeg 欄位標題，並使用 Field Calculator使用

RND函數填滿欄位： 
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4) 填滿欄位後，滑鼠右鍵點擊 RandomSeg 欄位標題，按照升序排序欄

位。 

5) 滾動屬性欄至街道區段的期望數目並選取之： 

a) 點擊欄目中的任一單元格以檢視 Record count box 的記錄

數目。 

 

 
 

b) 找到期望的記錄數目後，按住 Shift鍵，同時使用記錄條目

左側的灰色鈕選取記錄。 

 

 
 

6) 關閉表格視窗並返回至地圖視窗，匯出選定的 Streets 地圖圖層樣本，並

將它們添加到視窗裡： 

a) 滑鼠右鍵點擊已裁切的 Streets 地圖圖層，並選擇 Data > 

Export Data。 
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b) 確認 Export下拉式選單已設置為 Selected features。 

c) 將所選的 Streets 地圖圖層命名並保存。 

d) 系統提示時，點擊 Yes 將匯出的資料添加為地圖圖層到視

窗中。 

7) 從主要工具欄中，選擇 Selection > Clear Selected Features 取消選取街道

特色（Streets feature）。 

8) 如有需要，開啟新創建的街道樣本屬性欄，並匯出記錄供Microsoft 

Excel 使用（用於列印等）： 

a) 點擊 Attribute表格 > Options 按鈕 > Export > All 

records。 

b) 選擇匯出為一個 dBase 檔案，其可用於MS Excel。 

9) 如有需要，列印街段地圖以供規劃和現場使用： 

a) 在地圖視窗中，以名稱欄位標籤街段。 

b) 滑鼠右鍵點擊 TOC 上的標註以重新著色地圖圖層，改善其

視覺觀感。 

 

 
 

c) 切換到 Layout 視圖，並透過上方的 Insert選單添加地圖元

素，例如指北針與比例尺。 

 

 
 

d) 從主要工具欄中，選擇 File > Print，並選擇合適的印表機

和紙張。 
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e) 非必要選項（Optional）：選擇 File > Export Map 保存地圖

的電子副本。 

10) 非必要選項（Optional）：對於 AOI中的區域，添加區域多邊形圖層。為

了讓各區域街道樣本數量相符，使用 Select by location 功能。 

 

結果（Results） 

在 LINE的地圖圖層中，隨機街段樣本的期望數目。 

街段樣本屬性資料的 MS Excel 文件。 

紙本化或電子化的樣本區段地圖。 
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附錄二：資料表格──暴風（Appendix 2: Data 

Forms—Storm） 

本附錄包含所有需用於暴風前收集資料或暴風後使用常規暴風協議表格（非颶

風適用）的表格。 

 

表格一（Form 1）：記錄樣區長度及暴風結束前後的調查 

表格二 A（Form 2A）：暴風前的實地資料收集表（居住區域）。 

表格二 B（Form 2B）：暴風前的實地資料收集表（鄉村區域）。 

表格三（Form 3）：暴風前的社區總資料。 

表格四 A（Form）：暴風後的實地資料收集表（居住區域）。 

表格四 B（Form 4B）：暴風後的實地資料收集表（鄉村區域）。 

表格五（Form 5）：暴風後的社區總資料。 

表格六（Form 6）：地方、州與聯邦機構聯絡資訊。 

 

﹝請注意：表格的三和五所描述的計算會在暴風模型中自動生成。這裡提

供表格僅供你參考並在緊急情況下完成手動計算。﹞ 
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附錄三：資料表格──颶風（Appendix 3: Data 

Forms—Hurricane） 

本附錄包含所有需要用於暴風前後使用颶風調整的資料收集表格。 

 

表格一（Form 1）：記錄樣區長度以及暴風結束前後的調查。 

表格二 A（Form 2A）：暴風前的實地資料收集表（居住區域）。 

表格二 B（Form 2B）：暴風前的實地資料收集表（鄉村區域）。 

表格三（Form 3）：暴風前的社區總資料。 

表格四 A（Form）：暴風後的實地資料收集表（居住區域）。 

表格四 B（Form 4B）：暴風後的實地資料收集表（鄉村區域）。 

表格五（Form 5）：暴風後的社區總資料。 

表格六（Form 6）：地方、州與聯邦機構聯絡資訊。 

 

﹝請注意：表格三和五所描述的計算會在暴風模型中自動生成。這裡提供

表格僅供你參考，並在緊急情況下手動完成計算。﹞ 
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